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LA AT KB LT2 T Y & KT T TRODS T HERORPRT I
FT, U4 RUERL &L HEROBEBRE R UADEYON T T BRRIRENET,

ETNANZE, BRUEAT T OBBRERRINET,
B AT, BIRLIE AT Y TROD S TR OFHEMNER S NET,

1 BAERTTLZHT7IVE7 ) v LET,

2 [V—FER1HIT72VE7Y) v T25L, [MBEEOFEM] 21 NFESNER
EhET,
[FEERDOFEM] 21 L DO 1FIDITITHEE A BT RINET, 250D & 3FIDITIX
AF v Tvay hhLOERRFREINES, AHLTICE a2y Ea—424 L
DRI A DAZ T RERENET,

FDOARAF YT ay MIRWEBIZ, [Ron XAl EERRShEST, 2>
Va—& EOHEBICIE, FxvZ ~—7 F7203 linstalled] (f > A h—/LiEH)
EWV D HENFIRSNET,

3 FEASA D FENICH D 20DFNTIE, BIRLEERICOWT, 129HE 25
ODAF TV ay NOEBOT —FZRERINET,

4 EEO TEICE, [ZOERE OFEMICONTAS Y F—Fy NTRE] ) 7013
£, 2oV rx2 )y 95 L, BEERSNTOIHEERICEESH D
HBIZOWTA 2 =Xy MERPFTENET (2L 2iE, [Windows D 2
7 LERBEZEH) .

5 [HEROFEM] A 0 D[RRIV A NEZ Y v 7 LET, FontT DHE
RET7ANZTHTIEINGDFT v a 2 EHALET,

6 IHEROHERIEDoTD, U4 FYOE kichsRs @ Koz ry vy
LT, #A > ®[DevPartner System Comparison] 7 .t > K7 (2R Y 4,

BRY 4V FIIIHEEROLNERENET, 220D AT v 7y ay hCTRILE-7=
HHIEIERRSINEEA,

System Comparison Tid, FHEROFMIFIZN—T 3 U BENBEIND Z LIZHEE
LTLIZEN, aUR—R bONAN—T a VESPRRR LG, Bipba R —xr b
LHITESNET, HDar K=K FR2ODART v gy MIFEELTH 3V
PF—=R bDONR=D 2 VEEWRR LGS, a0 R—3 0 MI[RO20 FHA] EFR
SNET,

BUEORREZ IO LLRTOMREE & BT 2121, R Y 1~ oo [BIEOREBO, RO
RELOMERFM : 1) X - biloRFyTvay FERIRLET,

System Comparison DEAEDIEE N T L7 b, BT ICE L Lch— B X % HbH
LET,
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ZOEDOHE, RE, FITE I/ a NI INTKRT T, ZZFTT, System
Comparison D EATHIEIZOWTEARM 2N EE TE 2333, fEMERIC
ONTIE, TOEDED T THRATLIEIWN, £, X RATICHESFEHRIC
DU TIE System Comparison DA > T A > ~LVT ST IEEW,

System Comparison —E X

System Comparison #—t A (DevPartner Differ) Tlt, 2 Ea—FNEEIL
TWAHAE FHATRI2IELI00IC Ty Ea— X OREOR T v 7 a v MABEINIC
B ENE T, 2 Ea— X OBFENA 7 OHE REIORE 5 HICA Ty gy
k 2MERL &3 E §, System Comparison %1 > A h—/L4 % & | System Comparison
P —E RO HRICAT v 7V a vy PBMERSIVET,

WHAT v T vray b =2 T2 AR T v 7 a v RBMERS L, 0
PIBRIZE W O LHEIBR S vE T, System Comparison +2—7 1 U7 4 OFKET 7
ANOEEERT DL RFETHRA Ty T v ay NOREEETECTEET, [REFTS
AF T Ay hOBOET ] (2905—) ZBRLTLILEI N, 2AFyTvay
N 77 ANDYARXFNETHT—HEIZL>TEDLY T, — R T7 740 W
A R 1ATRA PR TY,

System Comparison % — & 2 I3EARDEILE TEIT SN E T, ET T OESHIT
HOREOVAT A Y Y —ANEE I ET, LEIZI U T System Comparison
PF—CADRE— T v TOMEE FENCHETEETR, HBMICA Ty TV ay
N & VERLT 2 EERRITIESIC 72 0 E 57,

B8SIRFvy7oay FREDER
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System Comparison & —E A TIER SN D HEIA T v T ay b A I T L,
BREFFT DA F v T v a v FO#L, System Comparison = —7 « U T 4 OFFE

Ty ANVDOETHREY £9, REZ 7 A/ (Compuware.Diff.Settings.xml) |
Program Files¥Compuware¥DevPartner Studio¥System Comparison¥bin

TALZ FUICHY ET,

RETIRFTY T ay FOBOER

System Comparison TiX, 7 7 4/L b T2IDHEN A F v 7 a v b 77 A LHBME
S, Z20%IIENT 7 AAD2BHEIBRENET, REFETDIAT TV a v FoKE
BETHIIL, RET 7 A /LD SnapshotsToKeep ¥ —ZZEH LE7, /=& 21F, UL
TOXF—IZERT L L, RETHA Ty T ay hOKER 30/ £,

<add key="SnapshotsToKeep" value="30" />
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HEROATIY

RFyvFay FEROER

System Comparison —EZXTlL, HHFRI2FRE107ICa 2 Ea—FOHE) R T
Tvay MMERENET (2 a—FOFEBRNPA T OGE, REIOESE)5 5%
ATy T ay MMERSNET) . ZOT 74/ MNEMEERTHI2E, RETZ 7
A )L ® SnapshotHour0To23 % — & SnapshotMinute0To59 & — & i f§ L CTHEE %
BELET, 22, UTOX—ICEETI L, BEIR T 7 v a v ORHIITEF
AI3RF42 571272 0 £7,

<add key="SnapshotHour0To23" value="3" />

<add key="SnapshotMinute0To59" value="42" />

R OB R EIL0~23 T, ZOHARRKEIL0~59 T,

P—EAOH LWREEAINIT DI, FEBHTILERHY T, TOHOEE)
ATy T ay NBMEREAOLE. HFTLWEREITKRO BN LHENT/RY £,
System Comparison CTHEIA T v 7>z v "B3ER IO 1 BIZ1EIOHRTT,

System Comparison = —7 4 U7 ¢ CTlik, A F v 7 v a v FOERKFIC, LLFO#E
WCRTHBEDOFE, N—Vay, AT —Z ARSI NET,

System Comparison 77 7' A V%l §T 52 & T, HiLWh T IV ZBIML, T—
BWIGE N AT~ A XTEET, 77740tk (303 <—) 2ZRL T
él/\o

% 8-1. HEROATIY

h7F3Y RHZhIHHEER

DR T LIER o ARL—TF4VY VRT LA

* .NET Framework

s GUA—NLTEVITYDFYya

« Java Runtime

o VRATLBEEH

e TF7AN VARATLDORXFEINFORA

SATFL TFAI | « Windows¥System32DARL—F 425 SRAFL IT7A4IL

+ Windows¥System32¥dllcache ® Windows 7 7 A JLIRE®D
Frva—COITFNLNRICE ARV—TF AT SRTFLT7
A ILAEEIE L =18 & 12 Windows DRESFIZER SN S, AL —
TAVYT DRTLI7AUDREEFRTVET, F7MIHHIET S
NEEDE, COTAHILEDT 7/ IILTHEBMIZERINLETS,

+ Windows¥WinSxS DY A ENAHYA K 72T
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% 8-1. HEROATIY

h7F3Y RHZhIHHEER

2" BHEINEER, N\—2a BB’ HLEE. ThIRFTENFET,

SNTLSERA CDIERIEL PR +1) D Add/Remove Programs 4 & 3 Uh S E5H
mohFEY,

Y—EX AVRAP—LENTVEY—EXDHEER :

o H—ERADRAT—H R (Ef7H., FLEHEE)

o H—EZXMNMERTEITHhIUE

o H—EXNIEHE

- EETBY—ER

AR—brTv T AB— b7V TOEES, COBERIIUTHSHEARONET,
TAT L « Windows ¥« L' kYU DOWin.ini 771 L,

¢« UFOLSRRY F—,

HKEY_ LOCAL MACHINE¥SOFTWARE¥Microsoft¥
Windows¥CurrentVersion¥Run

o FEEAZRE. TOYIL ITFALDON—D 3 VEBRNEENFET,

IE/Outlook Internet Explorer & Outlook D 1B:E &,

AVR—RT b « Active Setupl&., LR~ F—
HKEY LOCAL_ MACHINE¥SOFTWARE¥Microsoft¥
Active Setup¥Installed ComponentshoHiH Ehit-.
BHFFHF=IEZR DM 541 Outlook ~ Internet Explorer 3 > 7R—
*rUbERLET,

c LYRbLY F—
HKEY_ LOCAL MACHINE¥SOFTWARE¥Microsoft¥
Windows¥CurrentVersion¥Explorer¥Browser
Helper Objects M i S hf=Browser Helper+ 72 x4 b

s UTOLYR LMY F—hofiasniz-MIMEY Y E>Y (MIME
A4 TEMIME#EBT 27T 5—2av DT vEVY)
HKEY LOCAL_ MACHINE¥SOFTWARE¥Microsoft¥
Active Setup¥MimeFeature #7>zx % b

¢« LYRFY F—
HKEY LOCAL_ MACHINE¥SOFTWARE¥Microsoft¥
Internet Explorer¥Extensions m oifiH Shi=Internet
Explorer #i3&

« LR F—
HKEY_ CURRENT USER¥Software¥Microsoft¥
Windows¥CurrentVersion¥InternetSettings N5

I o8 —Fy FRE
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% 8-1. HEROATIY

h7F3Y RHZhIHHEER

IS UFDESZ, 1 VA F—ILFEHDEWeb T T Hr—2a3 0 EFD
REDHEELGE, IISAZR—ZANS5EETE S Microsoft IS >~ &
F—ILDES

o WebH—/N\—0DiEEH
o SMTPH—N—DHEES
o FTPH—N—0DOHEESR

SQL Server Microsoft SQL A X b—ILDHEER

+ LT R kYD Microsoft SQL DERFE

» Microsoft SQLH—EX LBEY—ERIZEAT 5 T—4

s AVAF—LNBEHDEA VAR VRIZETEIRE T—2R—2X
M syscurconfigs 7—7JJL& sysconfigures T—TILDERE,
System Comparison 1—7 1 ) 71 (&, #fisShf-EFa )T«
Z{EFA L TSQL Server [T £ A E . SQL Server ASiEEI &M
TWEWNEE., YR T—AR—XDHEEAFRESNERA,

AE YR T—EAR—RDEERTWNET HIHE. RTTE7H

DU MIE, SRS2DDTF AT I ERT H1=ODERSBHE

<Y,

[N (AN BRESNZFSA /1 \OHEER
o AVRP—=ILEHFESTAN
o FSANDAT—ER

LR LY LR M) DHEEEY 3 VOWEER, T4 ETRESIELD
ARUDEI VI VEBYFLAD, UTOLOR LY #5923 0M
HERZTIETEEY,

HKEY_CLASSES_ROOT

HKEY_LOCAL_MACHINE
WELSRM)DEY a3 VEHREZITARXT BHIZIE. Program
Files¥Compuware¥DevPartner Studio¥System
Comparison¥data7« LY kUMD RegistrySections.xml
T7AIVERELET,
LA R = T—2%2RET5=OIC+RHERSADETT,

74 BEDNRADT ALY FIDABLET 74 TANRT 1 DHEER,
FTIHIETRESNZ I7MNLIEHYFEA, RET H/REHR
A< 4 X9 BIZIE. Program
Files¥Compuware¥DevPartner Studio¥System
Comparison¥dataT« LY k!)DFileSections.xml

T71ILVERELET,
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LX) F—DHE
VAT LD L YA MY REERBIZT DI EIF LB ETH, VAT LI
TR OL A MY F—DFET D AREMEN H 5729, Ll d~ 5 % — O#iPH & 1%
5 EFERCT, ZOBAE. A VA= 2D dataT A L7 N (FT7 4N KT
Program Files¥Compuware¥DevPartner Studio¥System Comparison¥data)
IZ% % RegistrySections.xml 7 7 A LI T AL A NV DE® Y v a v i
ELET, 774NV ETRAT 7 vay MIEENDHLUARY F—Fd Y FHA,
*FE : System Comparison 1—7 « ') T 1 0 Snapshot Application Program
Interface (API) TCDI7ALEFERAT HHE. 75— 3 v OET
AREI7AILD1IDLEMIZH S ¥dataTA LI FJIZZD I 7 A ILEEL
WMENHYET, ERIE, BTRAETI7AILD
...¥App¥bin¥MyApp.exe THDHIHEE. CDT7AILD/NX[E
...App¥data¥RegistrySections.xml &% Y FTF,
HKEY_LOCAL_MACHINE & HKEY_CLASSES_ROOTD L YA MY = FU I CT& F
T OV A N F—DlIIY R — FINTHEREA,

VES L TCHEED® 7 v a v EAIRETE £,
LA R F— F—Z BWET D7D+ 2 ERBMLETT,

XX

<Section categoryName="XXX">YYY</Section>
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INSHA—A

XXX A—HY—A VAT A RZRFRENBATIVE, COBEEIA T3 oTY,
KEBEEDOHE., ATIVEELTLIER MY F—HMERAINET,
Yyy BRAICIEZRRTHSLORA M) F—, COF—[C(TEEFD

HKEY_LOCAIL_MACHINE FE1zI& HKEY_CLASSES _ROOT #¥EELFtH A, =&
ZI(X. KEY_LOCAL MACHINE¥SOFTWARE¥Microsoft¥Rpc DI RTD
F—ZINETBHICIE. UTOBXEFERALET,

<Section categoryName="Microsoft
RPC">SOFTWARE¥Microsoft¥Rpc</Section>

LOCAL MACHINE ¥—&=I& CLASSES_ROOT DT R THDF—ZUNET B[,
BHRXTFED MN¥] 28ELET, & XX, <Section
categoryName="All">¥</Section> EELET, f=L. IRTD
LR R F—%INET D LEEBMAMNDIDTEELTLESLY,

F—DIEMHMN REG_BINARY DIFE. &£FX—DEIE20/\1 FOADIRESLFET,

ol

RegistrySections.xml 7 7 A /L DHIZ LA FIZR LET,

<RegistrySections>
<LocalMachine>
<l-- CNERPCUTOITRTOLIALY £F-2REKTZHITT -->

<Section categoryName="Microsoft RPC">SOFTWARE¥Microsoft¥Rpc</
Section>

</LocalMachine>
<ClassesRoot>

<l-- CN(FClassesRoot ATDIARTEIRETBHI T, AHNA PEEOKER
F—RICBNFET -->

<Section categoryName="All">¥</Section>
<Section categoryName="Shell Extensions">*¥shellex</Section>

</ClassesRoot>
</RegistrySections>
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T AN NT, flx D7 7 A NVOFERIINESNETE A, VAT AOERIFICRE
T ANERNBRIZT DI LT ELS BV ETH, iRT D57 74 VOB ERKD & (HF
T, T 27 7 A VERET DI, A VA= "2DdataT 4 L7 bV
(77 4V F CProgram Files¥Compuware¥DevPartner Studio¥System
Comparison¥data) (Z& 5 FileSections.xml ZffifH L =9,

*»FE : System Comparison 1—7 « ') T 1« O Snapshot Application Program
Interface (API) TIDI77 AV EFERTHEHEE. 77U 7r—2 3 v OET
AEE I 7AINDLIDEICH D ¥dataT A LY FJIZCSDIT7AILEEL
WENHYET, EAE, ETAEIFALN
...¥App¥bin¥MyApp.exe THAEE. DT 74 ILD/RIE
...App¥data¥FileSections.xml &7 Y £,

IS ED D7 7 ANDEHT 2 X, FileSections.xml DHIDE 7 2 a3 VZIEE
LEY, BESCTHED Y v a v 2 8ETEET,

<Section [categoryName="XXX"] [filterPattern="{*,?}"]
[attributes="{yes,no}"] [programAttributes="{yes,no}"]

[recurseSubDirectories="{yes,no}"]>YYY</Section>

NG A—4A
categoryName I avnEE, XXXIFHTHATFITYELTRRESN
BLHTT, COBRMERELLEWVGE., TIA+I KT
FTA4LY R RRADBATFITVRIZEYET,
filterPattern T avnEt, 7T4ILEA—KFXFED* OFULED

XF) B&UV? (IXF) #FEALTIFAMIL T3 %
BELET. COBEZEEE LEWMEA.
filter="* *" LEHRICMEBINFET,

attributes FTLarvOXMLEM., BELEVES.
attributes="yes" LEHFRIZNEBINET, COEMHE
MNyes"DIFE. UTOFERSINESNLET,

flag read only (FEABMYZRTZY)
encrypted (FF&1t)

file length (77 A L&)

modified date (E#H)

REIBEDIHZE. Company B, Product/Eff. read-only
Pdebug G EDT—ILE T 7 A LEHITIREShFR A,

K



programAttributes

recurseSubDirectories

YYY

+FTLavoEE., BELEVNES.
programAttributes="yes" LRHFIZMEEIhET,
COREMMN"yes" T, T 71 IILBDILEFE . exe,
.dll. .ocx. *.cplOLVTFhHhDEE. LLTHOFO
ToLN—23 VEBRIPIRESNET,

version (/A—2 3 V)

language (EE&)
& ZIE, RBERIRET. H#R0OA VX F—ILHIZH
BRELITEBMENE=T7AUBHINESINERITET D
DENRHDZMN, —EOT 74/ TFAnRTF4 (FOTS LA
DIN—=23 20 E) FA VR =)L EIZEBEINTL
5 ENFREINDZELEIT, programAttributes %
"no" IZERET % LERTT,

TTLa OXMLEYE., COBMEERE LEVGE.
recurseSubDirectories="yes" L R#RIZANEEHh
9, CORMEMN"Yes"DFE. IRXRTOHITTa4LY +
DT 74 IVEBRNBIRBICIESNETS,

7 ANVEBROBRAGIEZRIGT 5T 4 LY Y KX,
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/]|

FileSections.xml 7 7 A L DOHZ LI TR LET,

-->
- <FileSections>
- <l-- TholE72740 €D YaVvOBTT -->

<Section categoryName="My Product">c:¥somedir¥somesubdir</
Section>

<Section categoryName="My bat files" attributes="yesg"
filterPattern="*_.bat" programAttributes="no"
recurseSubDirectories="no">c:¥diff</Section>

<Section categoryName="My Test Files" attributes="yes"
programAttributes="yes" recurseSubDirectories="yes">D:¥test</
Section>

</FileSections>

DevPartner W RII Lf=4 VX b—JL
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DevPartner System Comparison Id, 1 DevPartner #8E & 1352 A > X h—L &i
£T, 200RRD A Ea— BB LT, BRRDVATLAETT T r—varo
ENER DAL HERTILERNDH DL EE, 2O T a VREDNS LLER A,
VAT L U THEREZ RO D56, AT LMIMA D EE 2/ NRICHZ %
Z ENEFETY, Visual Studio <2t DevPartner #iE% 1 > A | —/LH 2, System
Comparison D&% A A h—)LF 5 & G0 v AT AR O BEE M E R & FF
ETDOBREGITRY £,

System Comparison % > A b—/L9 %21, DevPartner DA > A b — /L% E M
C [DevPartner System Comparison DA > A b—/V] ZFEIR L, A > A h—/LFJEIC
PEWET,

System Comparison (% DevPartner 7 1 & > AT E D729, System
Comparison Zf# 45 & DevPartner D1 7 A4 B ABMEHAENE T, T4 BV AD
FEANZ SV TIE [DevPartner Studio A > A h—/L A R IZFERHE SN TWOE 03,
UTORIZERELTEEN,

& /—Fmyr (VI ni—h) FARVRAEIFar Ly N T4V RE
FioTWB 4. System Comparison DFEITHIZL T A v ARMEH SN E T,
System Comparison 4 —EADMIEE Z O —ER|IZLDBATF YT a vy bD
ERETIX, A4 BV AIEHEINE R A,

& 14 HOFHHHIHK T DevPartner % %179 %5354, System Comparison =—4—
AVE =T oA ZAEEH L THEBEZET L EIC, 2014 HIFBISNET,
System Comparison #—E ADA A h—/ Vi, EERE, Rt o7 a v bo
TERREFICBRIR S LD DT TIEH Y R A,
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AXVEF AU DHBA—T 1 V) T 14 DEST

T — XV L LA B9 5 121%. CommandLine.exe & CommandLineDiff.exe
LWwr2o0a~vwr R IAf vy A F—T oA A TEET,

¢ Compuware.Diff.CommandLine.exe Tli, I Ea—% VAT LADIRD
AFyFvay FWMERSNET, 774N FTIE, ATy T vay FOKEHIC
FEHENTZHEEDT 4 L7 FVIZA Ty T ay bRBEMENETR, av K
TAVDONRTA—=ETT 4 L7 N ERETHZELTEET,
il
C:¥Program Files¥Compuware¥DevPartner Studio¥System
Comparison¥bin>Compuware.Diff.CommandLine.exe

C:¥Program Files¥Compuware¥DevPartner Studio¥System
Comparison¥bin>Compuware.Diff.CommandLine.exe c:¥MySnaps

& Compuware.Diff.CommandLineDiff.exe TliX. 2 O0DMFEDRF v 7
Tay b T rAMIEENDEN S, FBROFESD I T 7 A I
ExHEINET,

AFE : Windows VistaTEITLTWBEE. BATA LI FIADEZAH
RN HDZEEZHRL T,

WD /RT A —HF T computers (ZAULT L—AFLELTY) L, k45

TrANKTT, A7 ar T, 77 ANVEEZALT L7 N Z2EE

TEET,

il
C:¥Program Files¥Compuware¥DevPartner Studio¥System
Comparison¥bin>Compuware.Diff.CommandLineDiff.exe
computers SnapFilel SnapFile2
C:¥Program Files¥Compuware¥DevPartner Studio¥System
Comparison¥bin>Compuware.Diff.CommandLineDiff.exe
computers SnapFilel SnapFile2 C:¥MyResults

HAZ7 7 A EXML 7 7 A VT, 707 T A TridBo TR 4 ff
WTEET, 2O 7 7 A V% System Comparison =—7 4 U T 4 D
2P A U F—T 2 A ATH ZLIXTEERA,

a2 R 742 7ar 7 Ak, System Comparison =—7 4 U7 4 D¥binT 1 L
kY (F7#) b T¥Program Files¥Compuware¥DevPartner Studio
¥System Comparison¥bin) IZH VY F I,
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Software Development Kit

System Comparison (213 Software Development Kit (SDK) 23& £ ¥ 9, SDKIZ
XY 7 b =T BREEMTOLEO XS Ielkiernd ) £,

L 4

Snapshot Application Program Interface (API) ZfFH LT, 77V r—va v
B — VB HDIAR, T Y = g VOBBATICA Ty S ay hE RS
I 5 HERE

Snapshot API Z {42 &, 77U r—y a VBEIL. EHT7 7Y r—yva v
WB ATy 7 vay MERERIECEES, 77V r—va oI HlE
NEALZES HOIAENTZAPI 2 —LICLk > TA T v 7Y ay bR MU A E
N5OT, ZNEMEOZWIFRIHTE 7,

System Comparison 77 7 A Y Z{ERR LT, AF > 7T a vy NRINET 58
I & fEE 3 S iR

1T EAEDREDSE . System Comparison = —7 4 U7 4 BNINET D11 07
Y O (81 (291 =) 2B BhIUI+HTTNR, VAT 252+
(CHESS 2 72 DICBIMERA LB R GE81E, 7T —FBIGT 7 7 A v 2{FR LT
System Comparison +—7 4 V7 4 & HAZ v A A TEET,

API & 7T 7 A OREREIZ DWW TIE, DBED® 7 v a o THBALE T,

System Comparison Snapshot API

300

System Comparison Snapshot APIZ 32 &, dEHT7T 7V r—a v NAMH R
F v ay MEREAZHIMTE £9, Snapshot APIZEHTH L, UFERETE
F7,

2
2
L 2
L 4

ATy T3y N OIS

Ay —UFE R T — Ok

HEPE A T — & 2 DL I7 ik

TITA DG (AR N TTZ 74 EERAT5E)

Snapshot APIf&#(%. System Comparison{ > A h—/L 5 4 L 27 FURND2OD
BT L7 B UITERI S IV E T

L 4

DevPartner 1—H#'— H4 K

System Comparison¥redistributableV 75 (L 7 b UI(ZiL, BERERN
TIVr—2a DA A N—IEDDI EDTEDTA 2 ARGHEHD
TR T VBRI TOET,

Snapshot API 77 Vid, it DY 7 by =7 T4 ABKOSLIAIC
Mo THREMTEET, ATy T vay FOIERIZY 7 =T DIt A%
BT 20EIHY /A, AT v 7Y ay hOFRRERERIZE, 9142
B33 4D DevPartner ¥ AT AMIATF v ay NEEETI0LERHY £,



¢ Y¥System Comparison¥sdk¥SnapshotAPIHV 75 4 L2 VIiZik, 77V
r—va r TCOAPIOERELZRT Y TN TT Y r—va
(SampleSnapshotAPI.cs) 2SI TWVET,
API O 5152 Fi%9 521X, SampleSnapshotAPI.cs #ZMR L T Z &V,

Snapshot APLIZVB.NET, C#, v~ —Y C++/57 7 A T&, NET Framework 1.1
L20TCENRNENET T r—va y THEATE £,

SampleSnapshotAPI.cs 7 7/ U 77— 3 VOWNRFIZHE - T, Snapshot API HIZ5E

Iz TAL Ay RIZOWTHBLET,

AE: SnapshotAPIZERAT HHEE. 7TV Tr—La Vv OEFTAEI7AILDL
LALEDY¥dataT A LY M) ETTUHS—2a DT 4 LY M) RRIC
EHLZVLELHY EFF, RegistrySections.xml 77 A )L &
FileSections.xml 7 74 JLI&. A LALMEETH. ¥dataT 1 LY
FJICESRENHY FET, -EAE, BITAIET7AILLN
. ..¥App¥bin¥MyApp.exe THHBHA.
...App¥data¥RegistrySections.xml &
...App¥data¥FileSections.xml NEFEHET HIHELAHY FT,

AFyvTay FOER

Compuware.Diff.Collector it 7 A SnapshotAPI #E&E L F T,
7 7 A snapshotAPI T DL AT v v ay bEERTEET,

Public SnapshotAPI Logger : 1RV FEIS—DMEZEITIVIAD
( ILoggable logger, AVRBVR, XT3 0Tl 2ETELELTE
IProgressStatus FIH. BEOCHRANERICEST-6. logger D
progressStatusinterestedParty, EEEZEBOLET,

String pluginsSubDirectoryName ) progressStatusinterestedParty : #E#XT—4 X

AyE—CFENBSTEITRADAVRI VR,
2F v T ay MEEIZREBROD SATHEENH
B2, A—HP—ITTA—FNRv I EEDIEN
BEELGBENIHYET. AT aTnull#EL
F9,

pluiginsSubDirectoryName : T—42REBO 7t >
TULEHMSNRTAREI7AILOTA LY b+
VOB ITT4LI b)E, T34 00 ENEER.
EOBRBFET« LY F)EBET HH. nullEET
EMTEET,
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Ayt—00 ek

SnapshotAPI 7 T RILLFD3 DDA Y v REFELFET,

public string TakeSnapshot AFyFoay bEERL, EELETALI MY
( String snapshotDirectory ) IZHMLES,
public int GetNumberSteps () EBRT—ARF TS b EZITRMBRATY T

DEFBEEELET . £, TNITH L TES
RT—HAREHREFTEFES (ProgressStatus
AVB—T A RADHEMZDONTIX303R—TU %
SEBLTLLESL,)

public void Dispose () AFwFoay b F Ty MEBERRERA T
oY bTY,

UTFTOHIT, mbEARBRAT Y7V ay MERBIZOWTHHALET,

using ( SnapshotAPI snapshoter = new SnapshotAPI( null, null,
null ) )
{

string snapFile = snapshoter.TakeSnapshot ( userSnapshotDirectory
)i}

INTATy T vay MIERESNETH, =7 — Avt—v #ENEmIh
RN, EBRBOBRETIEHE VA TIELY XA,

Compuware.Diff.LoggablelInterface #{F T 25 &, A F v 7T a v MLEIFZ
WENHZTZT—LAve—VOoREEGHIECEET, 7SV Fr—vaila JHkEE
ERL T, ZOA v F =T oA A%REL, A v E—VEBORENT A RTEHEE
HLET, 2 PN TF U r—va v T, Ave—Youszsary—
JWIZH 719 5 consolelogger 7 7 A& FTHEL TWET,

DA VE =T 2 AFLUTD2ODR Y v RinbER S ET,

void Log( string message ) CDAYY RFEFUHTE, BEOXT—H2X
Ayvte—oonsinEhshET,

void LogError( string DAYy FERUHT E, T73— A vtE—20
message ) AJNEASIhET,
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EBOHE

TI3T40E0%

2F w7y ay hOERERES L OERT DI,
Compuware.Diff.ProgressStatus { V¥ —7 = A A%FHELFET, D1
B =T A ZFLUTD3ODAY v R bERSNET,

void OneStep () BFREICENL. EBRTELRTYITTFO1U9
YA RFTZaA—IL Ny Y AUy K,

void MultiSteps ( int BFREICEML., £#BRTEEHRTY IO
nbrSteps ) AV YAURTBaA—IL NV AUy K,

void UpdateStatus (String BIREICEML. HFLLWRT—E2RE0NET S
newStatus ) A—I)L XYY AUy KR,
newStatus DXFIEFH LR T—E2 RERLET,
—fREIC. CHITEBRAT—2RAOUIEZRO—E
ELTERRSINET,

& A EDRIEDYEE . System Comparisont—7 4 U T 4 NNET B 11073V
DOIFH (F81 (291 X—) 2&R) DAL+ TTR, VAT LEHoICHiK
THEOICEMERPLERG AL, T — BT T 74 > % Bl L TSystem
Comparison 2—7 A U T 4 ZHNALX <A A TEET, 2O arTlE, 7—%
BB7T7 7400 28R L, ROV TVEHERHLTTZ 74 N ED L D ITHEET
D20 RL, MAOT —2BIGT T 7 AV EERT 27BN T LE T,

IS5 A 1L, A —7 A A Compuware.Diff.PluginInterface.
IPluggableDataExtractor &#RET 5 1 >FITEHKO ¥ A 7% ETe NET 7 &
TVTT, FITTA LTI, RO DICNET AT —ZOE L~ VD hT I %
EFLET, 777437 —F &L, BENRFECTERERIC XML EHR%Z
BN4T25ZET, O LIEICXMLEXRNTT —2 2 ELET,

T TA AT DOA A M=V T 4 L7 MU Obin/plugins IS ET,
DT 47 Y OFTXTOH.NET 727 V7R System Comparison ¥ —E AT L -
THEMICe— K&, £ ¥ —7 =1 A IPluggableDataExtractor & FE¥ET 5
FTRTCOEATINA L AZ L ZESIT, T —Z OIS 77 7 A4 DY
A MIANBNET,

7T A v OVERR TR R BT 57912, System Comparison (ZIXLL T D 2504

TN T ANRBY ET,

& YU TFT VA D samplePlugin.cs, YU TINIRT T T A O EIR
LET, ZOV T TIHREERT =X ZNELITEAN, BRIIOVThT 2
VD2FDDT —H KAV M, WICHA LAZ L TOMESERLET, 7
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TITANIREISND A Y v ROFEHIIOW T, ¥SDK¥Plugin D7 7 A /L
IPluggableDataExtractor.cs &ML T 7Z &V,

o VUTNTITTA L THBEEITHO DD T 0 /T A TestDriver.cs, Zh%
EHT 2L, VYo TN TITT7AL DA =X LNDNDET, £z, ZOT 1
TILEHEH LT, BOCTHAASA A LT 774 OEBLIT2FET, 7
T4 TCHHOEREZ G TE 725, System Comparison ®bin/plugins
T4V NIICEDT T T4 E ML, System Comparison = —H%— o >
=T 2 A AFERIZa~ L R IAL vy A Z—T = Ao THBEEZITZET,

FI53740 O TIVOREFIR

T4 L OFERICIENST-0IC, TestDriver.cs & SamplePlugin.cs DY
TN T ANEHERALET, Y507 7 AL ¥sdk¥PluginT 4 L2 bV
(77 4/ F CTC:¥Program Files¥Compuware¥DevPartner Studio¥System
Comparison¥sdk¥Plugin) ([ZHMHESNTWET,

AFE: FFHL vikVisual Studio .NET 2003 TR T DHENH Y £T ., System
Comparison1—F 1 ) 7«4 Tl&/3A—2 3 > 1.10 .NET Framework Z{# /A L
FT . FNEYHFLLA— 3 VD Frameworkk TIEFS 91 V2 EILRTE
FtH A, Framework 2.0 D#EEEFERA L LGS, A TOEROFUEL%F
T304 VIEBMLT 20D EEEFERTEET,

YT T ANDEN RET A NEITHITIE, LFOFNEICENE T,
1  Visual Studio NET 2003 #fiHH L TV VUV a—va VEERLET,
2 ZOVYa—aric, 20o0CHETa Tl NEBIMLET,

& ClassLibraryl (XA T VTR TGATFV): Zo7uay=y NITTT
A OBRBITHERSINE T,

& ConsoleApplicationl (XA 7 vV —)V) i Zop7av=y MNMI7TT7 7
ALDOT NNy TIEHINET,
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Pyl —3 0 Solution]’ (2
- IE-'J ClazsLibraryl
- = SHEERTE
3 Compuware. Diff CollectorSche ma
3 Compuware. Diff Loggablelhterface
< Compuware Diff. PluginIhterface
< System
3 Swztem. Data
I Swstem XML
B fzzemblylnfocs
B SamplePlugincs
- IE?_] CGonzole Applicationl
- = SHEERTE
A ClazzLibraryd
3 Compuware. Diff CollectorSche ma
3 Compuware. Diff Loggablelhterface
< Compuware Diff. PluginIhterface
< System
3 Swztem. Data
I Swstem XML

- | | bin
- | | obj
App.ico

B fzzemblylnfocs
B TestDrivercs

3  ClassLibraryl v ¥ =2 FTUTEFEITLET,

a

Classl.csWHDLAE, YVVa—alr 2 A7a—I06HIBRLET,
VS2003 %A LTCCH 7 ry=2 NEERT DL, 207 7 A LBNEBY
ARSI, AZ— R T v 7 7740 LTHEREIRET, ZhZ2HIKRYE
FIZ samplePlugin ZBMT DL, =TI —0NHAELET,
SamplePlugin.cs
(77 4V F TC:¥Program Files¥Compuware¥DevPartner Studio¥
System Comparison¥sdk¥Plugin!i® ¥ £7) #BIMLET,
HEAGAIREZR T 4 L2 R
(7 #/V s TC:¥Program Files¥Compuware¥DevPartner Studio¥
System Comparison¥redistributable) ML FDT L7 U ~DEHR
ZBEMLET,
Compuware.Diff.PluginInterface.dll
Compuware.Diff.LoggableInterface.dll
Compuware.Diff.CollectorSchema.dll
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4

5

ConsoleApplicationl 7u v =2 FhCTUFEEITLET,
a Classl.csPdd%E, YVa—vary 7 A7a—FnbHIRLET,
b TestDriver.cs 771/l

(7 #/V s CC:¥Program Files¥Compuware¥DevPartner Studio¥

System Comparison¥sdk¥Plugin|Zl®HV F9) #7 =7 MIEBEM
LEd,
¢ FERATETEERT 4 L7 Y OUTOTEY T Y ~OBHEENLET,
Compuware.Diff.PluginInterface.dll
Compuware.Diff.LoggableInterface.dll
Compuware.Diff.CollectorSchema.dll
d cCclassLibraryl ~OZHAEBMLET,

e Io7uY=l  NEARI— Ty Tud=r FELTHRELET,

YV a—varEELVRNLTCETLET, 7y 7 £— T, Fr T NEaRxTy
TETT DL, T IA ORISR AR TEET, £, Yo TT
TA v T2 G XML 7 7 A VIMERENET, ZD7 7 A4 141%
pluginOutput.xml C, 7 A K RTIANEETLET 4 L7 VIS NET,

-<testPlugin>

- <c n="Sample Data Extractor Plug-in">

- <c¢ n="sampleSubCategoryl">

<s n="datal">datal actual value</s>

<s n="data2">data2 actual value 4/3/2006 10:42:34 AM</s>

</c>

- <¢ n="sampleSubCategory2">

<s n="datal">datal actual value</s>

<s n="data2">data2 actual value</s>

</c>

</c>

</testPlugin>

TestDriver > TV 7N 7T 74 L DEBE 21T ->7- 5. System Comparison
2=T 4 VT4 Da—F— A L F =T 2 A RETFAV I R T A F =T = A

TIDT T I EHATEET,

1 ClassLibraryl.dll %7 774> 37T 47 hVica—LET,

2 System Comparison D2—W— f v X —T = f AFolda~vr K I A4
B =Tz A RAEFERHLTA Ty T ay MEERL, BT T2o000RF v
vay hafERRLET,

3 20o0AFvFvay hEEELET, SamplePluginidi# A ARX T T—

DevPartner 1—H#'— H4 K

ZEWET DD, 20DAFT v 7y ay MIULIZOMEARERENET,



b, ] Gompuware DevPartner System Gomparison

HFIVBIHEE HE0OFd

Systern Info (1) gﬂmfle Data Extractor Plug-in $8:2 2. 1/EEET =T |?Nt®-‘fﬁﬁ§.§\ w |
ﬁﬁf;i;” dFF'lfDS d(fits 0 ] FC1 (2007/11/21 11:21 -7kEEQ] PC1 (2007/11/21 11:22 - 7KEEE )
Services () [=F sampleCategorny

Startup lterns (0) data? actud value 2007/11/21 11:21:36 § data2 actual value 2007/11/21 11:22:25
IE/Outliook Components (0)
IS (0}

SOL Server (0)

Drivers ()

Registry (0)

File (0

Sample Data Extractor Plug-in (1)

AT MEER:

This plug-in is for
demonstrating the basic
structure of a plug-m.It
daes not collect real data
Also, it will always show a

8-4. YoINTSTL VORIV FD

TS554DERETR

TIGTA VDA =ZALEER T2, WAZ L T T 74 &G LT, BT —
HEPNETEET,

TITA U EFRFTDEXIEL, WET DT —XOMBIZRICER LT EEN, LER
AR TE D LI ICREERF LET, T FBRBIZA—KDER R o0 > 254,
ZTOBEROEY OF =ik EnEgt L CBEOAR—Va 0T T 74 TT—H
MeE 2 T4 5 HIEICHOWTIE, EAT T 74 0T ] (3082—) 2BHLT
<FEEW),

TestDriver M L CIERR L7 7" F 74 L 2 FATT 5 & MERRRNERIZ /20 £77,
TFITAOHNBEN TH D Z LR TE b, System Comparison 2+ R
TA AE—T A AEMEHLTTARMLET,

1 T3 ERBA ARV T 47 MY Oplugins 77 4 L7 RUIC
At — L% (TestDriver.exe 7 7 A /WEIT' T 7 A DT A MNHRDT,
a—FTHLEEIH D THA),

2 TITAURT—HENET HEIRIHESINHDI2ED I Ea—F T,
avwr R Iy IarsIn
(<product dir>¥bin¥Compuware.Diff.CommandLine.exe) % FE{TL £7,

3  System Comparison t—%— A VX —T = f AZFEHL T2 oD A} 7
Vay MNEHBRLET, HEAPHERETE DT T,

4 RFyTvay bEERTDEXICTTIA UTIRE LT —2REFEND &
912, System Comparison %— bt 2 ZEiELE) L £,
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BRIS5J4VDER

—HET o L7 MY (ERERGITICOW TR, temp BRBREAHEZ S M) ©
DifferEvent.log Z s L, A LML LES, 7774 VS,
ARG AMpEND & ANV O IRHhShET, Z0bE, T—2D
B—F, 7rr—F ELEREa-LVORICEELZTZT =T, BZITA N
FAERSILET

%72, IPluggableDataExtractor.GetData 2—/L® ILoggable traceLogger
NRIA=ZIZEoTrZIcH LT —b, ZO7 7 A MCEZAENET,
IPluggableExtractor.cs &ML T Z &V,

TV EREBLED EIZ, WETDHT—F2EETIHERHY T, HWVA
FoFravh TrANEHLWA—D g DTG THER LT AF T
vay eI sr L, WELET—XIE—ELEHA, System Comparison = —
T4 VT, ZOR—HEMHERLFEET S0, BT DWREENH Y 7,

AV —BLOA T — RN—=Ua VEBEEERT S Z & TR BB il
TEET, FITA DAY — "=V g VESNRA T YT a vy METRERDEA,
(TT 740 AX—<(ZHEHERH Y FHA | EHESNET, v~/ F— =T a0
RIpDERT, LT —HDAT—Z AN WAy T ay T IR LRE
nwEd,

WHET 2T — X ZHIR LD T— X OBEEZEL LI T572DIT T 74 &k
FT 256, AVY— N—Va BEEERTLH 2B LET, T —%%E0
THEDIIT T I A EBERT LA, —HNZIE~ AT — "=V a VEEET L
FTtaTd,

O A EEAET 521X, SamplePlugin D/N— a & E (RAIL1.0) 22X H
LT LET,

public PluginSchemaVersion PluginVersion

{

get { return new PluginSchemaVersion( 1, 0 );}

}
AE: TSTAUOBEBRELITHIBRSBELEES. £9 System Comparison H—
EX%{E1 L. System Comparison 1—H— 4 V8 —J 4 REZ#ETL
T ARL—TFT A4 VT PRFLAIT7ANLED YT LEVELSIZLET,
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IS5540 AXF—IDEELER

TFITA v AR =BT DI, ATy T vay FEBRLETS, Ay
Yay MIBT T 74 BNIUE LT T — 2 RN EEnE 7, IOV T,
¥sdk¥Plugin @ diff-plugin-schema.xsd 7 7 A VA S L T 72 &V, ER %
fHF 7= XML Y > P OPFea L FIR LET, HHTE 23E L BEO A0

DET,

<c

n="MyApplication"

descrip="text"

schema="1">

<c

n="MyCategory"

missing="text"

error="text">

<s

n="MyData"

search="tl t2"

error="text">

Actual Data
Value

</S>
</c>

</c>

&b 4MElD Category / — KIF TS5 54 VAT,

T34 0 DEF, COTFAMIATIY YR MIKRRSH
F3 (VIDEAD,

COTHFRKME, ATTVEBERLIZEEZFIZUIDETIZRTRS
n£Ev,

CHE"ICSERELET. FILLWAA—=S3 00 T35 4 VLI
DYY—REEBMENGIVES, COEEZEELEY.

FARARENTVETRTOATIINUIDASY D42 FIIC
RERENFET,

COBRNFUIDAAY T4 v EIICRRTEN, KBIZERASH
FY,

AFoar, SOATITINESI—ADRFy T ay kIRED
NOBMESICRRTETFRAMTY, EZIE. N—UaviE
WO TR M—=IVFEH] BEDL O TLETFHERITT,
AT ar, SCOTXRMNERET S L.
FHRAMY BICTS—AFELIGAIC.
RERSNFET,

FTRTOT—E2EXFHNTF—2TT,

ZONFIUDT—4
ZOFFR AU

COEBIFIUIDAS Y D4V FIIZRTESh, EBICHERSH
9,

TFoar, UD TRl Voo DRABEERRLET . BER
Google [ZEEhFET,

AFToar, COTHFRAMEEET D L.
BRARMYPICTS—IRELEGEIC.
RRENFET,

LU b EHOREDT—5 TT,

ZOATIVDT—4
ZOTHFR MU
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B /N— 3 D Compuware.Diff.PluginInterface.dll.
Compuware.Diff.LoggableInterface.dll,
Compuware.Diff.CollectorSchema.d11(31.0.0.0 T, ZNnHDT T Y
DNN—=2 a VEZINEDLRVNEY BRZA X LI2T T 7 A NIE5H% DN —
¥ g @ System Comparison +—7 4 U7 4 TH#EL £, TR T VIZKER
EENMA NS E, A=Y a U BSNEAET, 0BG, HiLnrer7 i
KHLTCTIZT7A 2 BNV RTHLERDHD 7,
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T8k A

DevPartner Studio Enterprise
Edition & TrackRecord

DevPartner Studio

& DevPartner Studio Enterprise Edition D#t &

& DevPartner StudioEE®Q V') a— 3>

* HAEEDHE

& TrackRecord & DevPartner Studio

& DevPartner Studio ® TrackRecord & D&{E

# TrackRecord & DevPartner Studio D /3Ly 44

Enterprise Edition MHEE

DevPartner Studio Enterprise Edition (EE) #7425 &, FHEIZ, T uv=s
N CHREEDME L XAREA AT —F R EO BIEEERT M2 L0 EfICT
HITE2 X927 £3, DevPartner Studio EEZfEfH+25&, nv=/7 NEH
FIY 7 v=T Fuv=l e PELEBVICED D7D ER BAEN R T 1
U MNElAERETE BT —LAD A N T EEEERIC N E Y — VEFRIT
xFET,

DevPartner Studio EEI1TBEOBGEY 7 v =7 VU a—3 g LV OEEEZ D

BTHE L. HFHLWEREZ 24 L £ 9, Enterprise Edition |21ZZ D~ == 7 /L Tii
B4 % DevPartner DHEREDOMIZ, UUTFDO IR —%> R A>TWET,

TrackRecord HEF—LOEODBN-EREREE, 4R VEBHE. B&LUT—Y
70— H¥R—F
Reconcile VIED I THRETF—LDI=OOERANLGEHEE

DevPartner Studio EE Cit, U TFTOHETT ey 27 b T—X ORE, BIE, FoR,
BLOEHEITNET,
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70X

& JUT 4 INRATuT =l b T—FERIR L CHFET 57200~ A LA h—1
BE DY~V

* FHOBERTuvRCE LIEHETT X E2BT DAL~ A XARER T —
7Ja—

® Web A X —TxAA2kBTaV2l MER~DVE—K T 7 &R

o HERTuT =/ MER~OEELZBMT HET A —IL

V7N =TIV —TIIENENMBO T a2 R ERLET, TrkR IR
TV x/ MOREL LORGHEREN D HES I OWMRER E TEHEAT L7200
—HED T TT, DevPartner Studio EE (21X, F—2DWMED Tk RZHHHET
FENBAR FIEOMGRRE 2 R 2R H Y £7,

Tt AOFNILLTO LB Y TT,

*  E{fFoililk

NN ObA A =g

HiffLea—
WERFES T =T

EETT =T
Y—A a— FHBEH

FH~ A LA =2 TOFHEH

TR AR LT Y=y FTE, UTOMER O ORAELET,

® TANEDTFY r— g OERFCHEMER

® HAOMME

& MRTA 7HA I NDO%RIETOERLRERANRINDAREAEE
® BRKARTEROME (A7 v 7] LHIND)

TrEANRFHICERINTWS e Y7 T, FHEICR o ey h otk
ITIRMOEEERNELS RV ET, /2. 7B AL THEF—LDOERbEEY
FT, B0FLIATHZfAEIC L D &, TRBREWEFHESNEREED I B, kR
BT WS TEH O TWZBIRE L 20% 72 72Dk L, 7 uv A2 BEEH LT
ST T T BRRHE 1L 60% T LT,

DevPartner Studio EE [ ZE&tOMFED Y 7 Y = TR Y at 2 I2EE L, LB
L TF =L L b7 me Ak 2T Y — v ERIELET, £/, F—20
J—77ua—%B b L, A NN—IZFDOV—7 T u—\ZxT b ELE Y, 7n
T ALREERESEAEELHVET, WRAZ A AARER Y — 7a— 5 —0
HER LA S hED L, Y7 F =T ORENRELEL, BT a2 RnE4H
fbanxd,

L R IR IR JNR AR 2
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DevPartner Studio EE®DY Y a1—<3 Y

DevPartner Studio EE 1%, — %Y 7 b U = TR T — AN EET 2 BEICHT 5
VYa—varERftLET,

o Tuvxy NEHOUE

& I—ROEEMZEDALZLIZLD, Y7 bU T HEOME

& EpEMEOM B

Jaovzy FEBROWRE
Tuvz NEEBTLEOIC, LTORIZOWTHREIZHTHNSHER D D 7,
® T—LNRTTIZRET LEZRAY

FEETLTWRWH RS

T r—g D a— ROEEE

TFY =gy T A OREME

7Y r—3 g v OIEEME

L 2K 2R R 2

7aY 1) MEROBIK LB

DevPartner Studio EE (Z1%, TrackRecord Zf# ] L CE#IAUIC 7 1 ¥ = 7 MEM A 1BHF
THENTHERENDH Y 5,

Y7 =T FuYes FOFEICIE, 2ROV VR FELET, ZhbDY —L
T VY —=RADED YT ATV a— T UT 4 HNRNAZ AT I E ORI R I
HOPTEIASLH F9, DevPartner Studio EE LLR[IL, AR Iz oy =/ MiF
B2 T — 2 A 2 MTRD E LT, BEEOT Ry =2 P T, A7 Y2 —Lin
ERINTY, el rav=r Vel ey 7 FoRKERED
BB . MRADEE SNV T2 eR3bV ET, eyl N 77
=27 =T TIERRO BB BT 2 Z L IETE EH AN, Microsoft
Project & TrackRecord M ]I DevPartner Studio EE 2853 5 Z &1L » T A7
Va— VEBPICHFAETE LI L,

VI2roz7REORL

BRE LT AN oY =T1%, V7 b =T A 7 V&K% i# L C DevPartner %
fECcEET,

A—H—HRETHMHEEZRRT S

DevPartner Studio EE (oo Y 7 v =7 Fu v/ Mgy —/L S 1380 | R
W Z BT DR -T2 T 7 —FICLY, NI a—FOR LRy 7 T,
TRy TADREERHL, EETEET, REORMEMET DI, Tr T
LOMEEZ B R TS Z EREHEIZ/Z Y £9°, DevPartner Studio EEDT /Ny 7
HERIL, BV A 7 L 2B LT, ERICOEMICLBELXELET, 20 LD
\Z DevPartner i35 2 & T, =7 —OFRALEELMEIZITV, BZEHE 2 K
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S EMDRL

MR CE ET, Fo. VAR— FEMBEIER TE 2720, BHRBEDBAEAB LIV
BEREL RN — P 2 AT oA N AET,

T —DHIITRERADOR S — MIEICTEERA, =TT —EEETDHITIE, =
7 — O, Fifk. BLOBEIRAZITW, BEOELIEMZRDDZLERH D FT,
TrackRecord {45 L. 27 a2 KESVNEEMEENET, 2LV
WENL L OIEEDP BTSN D OTEEERM EL, 7RI Ar YV a—LOf
BIEN KRR DO E FHRDLDOEHF LB TEET,

TuYxl hOVANA M= (a— FEEFCEMR A2 EOBEBERBM) 777 —
FL LT, RRORREGOH, a— FEER, F—L22K0a— K I3 v VkE
fiZpo7eyos b T2 EBICFERTDHZLEICED F—L2D A R—2EN
EIEmREEZ RS2 2N TEET,

DevPartner Studio EE = —%—{%, #NFfh7uaP =/ b F—F_X—X | Z[EHF DOIE

WO 2 —FERTEET,

¢ FHHFITu ol bOEKBEREL, EERT A MRETINTNDINE
IMEBFLTC, MEE SOOI LB TEET,

¢ BIRFIL, BAIHUBMNEILRZ A7 DY A NOVERK, BREICEST-4 27
DL, a— FTOZT—HHERAT Fr—< 2 X TR FETV, HEEHRICE
P ENTEET,

& TAREZ—IL, AT ELEHOBBED AT — & DB, BNV v P OFEITTER
INET—EZDO~— TAN T U0FET, BIOMEDOEEXOBMEEZIT S
TENRTEET,

® TA X —iF, ALEEEORITRY, BEEORERY, B2 —Y— 1 F—
Tz A ADETRF A B CE ET,

& TAR—bF a—F o x—ZiF, BBAOAREELT A N ENDHHR EOEHRE
TIPS HBEL, 2—F—DfEER L BT T,

ZOXIIZ, Hx D= —PNRERERZT 2 TIERLMETE L0 T, AEEN
M ELET, [Milestone Summaryl 72 EDE 2 —I2i%, ZOEREFERTIZDD
AUTHXAMRHYET,

V7 R zTRBE TR Y=Y MIZET, i T=—X b B 3, ALa
HANTH, EITHOTE Y27 MBI L CLERFERIE, BT EI0ENET,
DevPartner Studio EE i, v =7 bO&Er. KRBT AR O X A 728K
HERFEZECINSOBEHREMZLET,

DevPartner Studio EE (2135 H /0 UDMARENT-ZHOT — &2 X— 2 fFHRO
Ea—nRb TR, 7av=y MERORT L FRICHT 22—V —0ERITFN
FhH729 £9, DevPartner Studio EE Clt, LA R— b, 74 —4, U—27 7 B—,
Tuvzl b, BEWEROSYA T 22—V —D=—XZHEDLETEIKICH A X~ A
ATEET,
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DevPartner Studio EEIZ1X, Y7 b =TR¥ e/ MEHREZRHEL AT S
720V —= LRl H0 ET, ROy 2/ NOBW Yot A& REIZTHEER
HWRENSHEINLTVET,

TV = a VR R Y sy NCHEBEREYIOEIL. = R a—F =KD 5
BHEINNETDHZ L TT, WRIZ, FNLOEMZHET —2 LT A N F—AICIEMIC
B2 BAMENHY 9, Reconcileld., o= 7 NEAOILE., B B L OB %
1TWET,

Reconcile #ffi 9% &, Microsoft Word # =5 ¢+ # & LCHEHA L, BEfFE2INELT
BOATeZ LN TE E9, Bi% T — L1 Reconcile Project Explorer % i fl L CE {4
DR Z MR T& £9, Reconcile B & QADirector D[RIME LB Z ik ->T, 7
AbhTar—UyEBEABERL, TAMERET AN T URBEMNTHZLRT
xET,

TrackRecord & Reconcile D#AIZ L > T, REALREEZ 0 Y =7 b EAFICEE
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/Dlisable] BELETOERFLFY—EXOT—24WMELEMIZLET,
/Rlepeat] /DRA Y FEFERALTIOIT7AIEEHNCTHET, BE

L0 RERTTEHLLICTAITI7AILDBTHONET,

TDHDRAL v F
INEDAAL v FIEA T arTY,

/0 [utput] tyiary I7ALOEATALY Y FETaLY MY
LRRIERELET,

/WlorkingDir] A—Hy rOTORRFLIFIY—ERADEETALY L%
BELET,

/PROJ_DIR DevPartner Studio 7Bz FDT 4L P EEELET,
TLAYR NG EDEFREHRET HEEIHERAINET,

/Hlost] A=y rDKRA S AVE1—2FEELET,

/NOWAIT NYF T7AILTEBEDE—4 v < /NOWAIT #¥EEL T
DPAnalysis.exe #{#f3 5 &. processl DRRERIC
process2 HNEEISNFET,

UTFICHZERLETS,

DPAnalysis.exe /Exp /NOWAIT /P
c:¥temp¥processl.exe
DPAnalysis.exe /Exp /NOWAIT /P
c:¥temp¥process2.exe

#7320 /NOWAIT R A wFEEKLT
DPAnalysis.exe#{ff3 5 &, processlNETLTH
5 process2 MEITINFET (TI+I/L FOEE),

/N [ewconsole] HLWIATVR D4 RO TTOEREERITLET,

DPAnalysis.exeZ#FHALTX—R—FOANARELZO Y
Y=L 7TV r—2 a0 E 5T 51548, /NewConsole X
AV FEFRALT. ANWEZFANDIDY—IL D4V D%
B BENHY ET,

/F[orcel [DevPartner %4 74 FCIC++ 4 VR by LA T—23 V] T
AVARYLAVRLTWEWTZYRR—S a—RK 77
T—2avIZ2o2WT, ANLY SR ERIFNT+—IT VRS
HOTOI 7ML EBFIMIZRITLET,
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IR ED/IR & /O[utput] RA v F

7 (/o) AA v FDINTA=Z L LTHIMFMSE O A ML, 77 A VA&
DG, U TIORTOTNDOTIET AR TS 2058 RH Y £,

/o "c:¥test directory" SR TRTLET,
/o "c:¥test directory¥" AT—Y 1T TCEYA FERELTETLES,
/o "c:¥test directory/" T4+T—K RS9y aTHRTLET,
SHATay
INSDAAL v FIIA T a T,
/NO_MACHS5 MO Ly FTEOLSNI-BHEOBRN EE/SIZL
£9,
/NM_METHOD_ GRANULARITY TFT—RREDHEFAY Y FLAIIZHRELET,
TLARUDBTIFHILETT (IRTF+—I AR
0)}}‘)0
/EXCLUDE_SYSTEM DLLS SRTLADT—RWEERNLET T+ —
TUADHDH) .
/NM_ALLOW_INLINING ATA0 AUy FOETHEASA VR Ry ILAY
T avERYIZLET,
/NO_OLEHOOKS COMMDIREEEMIZLET,
/NM_TRACK_SYSTEM OBJECTS VATLATO Y FDEIYHTEBHLET

(AEYDFDH)

=TI b RAYTF

WA, 1DOTETBRIRLET, e A E T — 2 LT, =57y FEEELET,
H—7y FOARTELIF AN ADH LITHRET 5T XTOFEIE, #—7 v MIHT D

GIE- S QraN
/P[rocess] A—4y b TORRZH/ELEFT (FTAERIZHT 515N
BWEET),
/S [ervice] A—4y bk H—ERZRELET (H—ERITHT B51HHN
mEET),
/Clonfig] BRI7AILENREREELET,
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DPAnalysis.exe & XML 7 7 1 LD {EF

XMLKERR 7 7 ANV EFH L THOTE v a o2&+ 5121, /config AA v F &
¥, #OZ2—4 v e LTELVEEDXMLEER 7 7 A VEEEL T, 2~ R
4 )5 DPAnalysis.exe ZFEITLFET, WILHIZRLET,

DPAnalysis.exe /config c:¥temp¥configuration file.xml
W 7 A NVEFERT DL BHOTREARY — A2 T B 7 7 A VB I OEHET

EFET, BEOTu v RAE T T 7 A NTHHEEX, Web T 7Y r— gV EGHTT
HE XTSI L E T,

DPAnalysis.exe #ffifl L Tk v a 4 Bth7 % L. DPAnalysis.exe & MF-UMH
LIV AT A EOT a7 7 A VBT e AT bizkyvay avyie—L V—)L
N=REBLET, VS —D@ A Y AS L AZER L TET R EADE Y
varvarikr— LT rvarEFETLET,
Wil ” 7 A VOB Z L TFIOR L ET,
<?xml version="1.0" ?>
<ProductConfiguration xmlns="http://www.compuware.com/products">
<RuntimeAnalysis Type="Performance"
MaximumSessionDuration="1000"/>
<Targets RunInParallel="true">
<Process CollectData="true" Spawn="true"
NoWaitForCompletion="true">
<AnalysisOptions NO MACH5="1" NM METHOD_ GRANULARITY="1"
SESSION_DIR="c:¥temp" />
<Path>ClientApp.exe</Path>
<Arguments>/argl /agr2 /arg3</Arguments>
<WorkingDirectory>c:¥temp</WorkingDirectory>
<ExcludeImages>
<Image>ClassLibraryl.dll</Image>
<Image>ClassLibrary2.dl1</Image>
</ExcludeImages>
</Process>
<Service CollectData="true" Start="true"
RestartIfRunning="true"
RestartAtEndOfRun="true">
<AnalysisOptions NM_ METHOD GRANULARITY="Q"
EXCLUDE_SYSTEM DLLS="1" />

<Name>IISadmin</Name>
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<Host>remotemachine</Host>
</Service>
</Targets>

</ProductConfiguration>

XML 771 IVDESR

B
Type

MaximumSessionDur

ation

BEHRDER

Ll

XMLA#ERR 7 7 A VOERIZONTI LET,

RuntimeAnalysis B3&

<RuntimeAnalysis Type = "type of analysis"
MaximumSessionDuration = "number of seconds" />

2L

WZH, [ T& 53R, Performance., Coverage, Memory. ¥ 7-!%Expert
T, TNHOBRIET, VA NT 2T XTOX—F v MR LTONZ A 7 2HEE
l/jzj_‘o

FTvav, BMLIESEE. T 740 MY EHA, BETD L,
DPAnalysis.exeldt v a Vv OETEZ ZOBEIZHIRELET, =& 2R,
MaximiumSessionDuration="60" Z{§& L. (¥ —E R|Z
RestartAtEndOfRun="true" i L C) —v 207077y AV EHthT 5 L,
60 #7%|Z DPAnalysis.exe 3 — U2 & EIL L, y—E 22 FHEHE LET,

FTHLURH 1
HER ProductConfiguration
nE L

D2 AT LiEDOE Yy v a VIFRAZERLET,

ProductConfiguration# 7 IZ%¢i} CRuntimeAnalysis Zff 39 5 il %& LL FIoR
LET, ZOfITHE, Type B AT 4+ —< U 20 & T L. &K 1000 £ O RffH
ERELTHET,

<?xml version="1.0" ?>

<ProductConfiguration xmlns="http://www.compuware.com/products">

<RuntimeAnalysis Type="Performance"
MaximumSessionDuration="1000"/>
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Bt

EESOLE

Ll

Targets B

<Targets RunInParallel="true or false">

</Targets>

RunInParallel

A7 ar, truefmiifalse ZRELET, AT D ET 7 4L M true T,
BEOX =Ty VERBETHILA ¥— 7 vy NOETHIEEZERLE T,
RunInParallel ’ true M4 . DPAnalysis.exel|i¥ —% v hDO7Fatv R L —
ERENEF e TRAT 20T, o X —4 > FRFERHIC PTLT) FATEh
*9, TS DS, DPAnalysis.exeld, HIOX —7 v FEEEBHL TR TLT
M, WOHE—7y N3+ 250T, ¥—7 vy MI—EIZ1o7 > (EFID) FET
SNET,

THLUR# 1
HER RuntimeAnalysis
S Process. Service

W, 1O F 213845 D <Process>T b £/-ld<Service>= F VDT v
ZRBLET, ¥—F v b7 ALY —E AT, T 7 A VITHEESA TV
BBt S E T,

Targets HEAZEH L, 1 oD <Service>EH L 250D <Process> R HET S
FZLLTITRLET, ZOFITIEZ =7y RRWATLTEITEND LD IT,
RunInParallel 2 truell7e > CWA Z LIZHER L TLEEN,
<Targets RunInParallel="true">
<Service CollectData="true" Start="true">
<AnalysisOptions NM METHOD GRANULARITY="Q"
EXCLUDE_SYSTEM DLLS="1" />
<Name>ServiceApp</Name>
<Host>remotemachine</Host>
</Service>
<Process CollectData="true" Spawn="true"
NoWaitForCompletion="true">
<AnalysisOptions NO MACH5="1"
NM_METHOD_GRANULARITY="1"
SESSION DIR="c:¥MyDir" />
<Path>ClientApp.exe</Path>

<WorkingDirectory>c:¥temp</WorkingDirectory>
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</Process>
<Process CollectData="true" Spawn="true"

NoWaitForCompletion="true">
<AnalysisOptions NO MACH5="1"

NM_METHOD_GRANULARITY="1"

SESSION DIR="c:¥MyDir" />
<Path>TestApp02.exe</Path>
<WorkingDirectory>c:¥temp</WorkingDirectory>

</Process>

</Targets>

Process &

<Process

CollectData = "true or false"

Spawn = "true or false"
NoWaitForCompletion = "true or false"
NewConsole = "true or false"
RepeatInjection = "true or false"

>

</Process>

/DAL v FEEHA LTI a7 7y A NVEEHITHET, BELE A Z2FETT
BlNZT a7 7 A NBNIThIVET,

CollectData

A7 a, truef izt falseZRELET, AT D LT 7 40 M true TY,
H—y N TaRRZONTTa T s A NVEEINITHNE I ERELET,

Spawn

A7 ar, truefizidfalseFHRELET, AT DHET 740 M true T,
DPAnalysis.exe WNfRELX—7 v bEFITTHENE I »ERELET,
aspnet_wp.exe £7-1Xw3wp.exe DFH ., truelliRE L2V T ZEW,
DevPartner 7> ASPNET UV —# — Fu v 2 A EHEFTTHZ LT TEER A,

=727y O Web~—T %< Z & TASPNET VUV — 0 — X% iE# LET,
NoWaitForCompletion

A7 ayv, trueF/tidfalse ZBELET, HMWKT D LT 710 Mifalse T
T, TT7ANITEH, 7B ARNETTLETRHELET, truelliET D &,
2 —70y NRFETERBTHETLEIAE L EH A, DPAnalysis.exeld,
(Host EHEAMALS) VE—F ara—F o7 2% LEEA,
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CEOLEE

il

ol

RuntimeAnalysis %% MaximumSessionDuration B3,
NoWaitForCompletion % F# & L %9,

NewConsole

7 ar, truefcltfalse B FRELE T, BT DHLET 740 Mifalse TT,
DPAnalysis.exelIFHL\Wa LV —)L U4V RUTH =47y h2FEITLET, T
7 # )V N TiX, DPAnalysis.exea~ > R T4 & AT LIZRI L2y Y — L3 fEH
I %9, DPAnalysis.exe Zffiffl L THF—AR— ROANBKERa Y — 1L T 7Y
r—3a U ESHTT 584, /NewConsole A A v F&#MFH LT, ANMEZIFAND
A= U4 FUERSMERH Y ET,

RepeatlInjection
F7varv, trueFizidfalseFFELE T, AT H LT 7 4L bt false TT,

false ZHI/RBNCHRET D E T, ¥—F v MIFEfTINLI =TT e 77 A L E
iﬁ—o

ThLUR# 1 DF TS
HEH Target
S AnalysisOptions. Path, Arguments,

WorkingDirectory. Excludelmages

H—0y FOFATARET 7 A NV ERE L E T,
Process DB LI FIZR L £9, AnalysisOptions, Path, Arguments,
WorkingDirectory D&% 7 H{HH L £ 7,
<Targets RunInParallel="true">
<Process CollectData="true" Spawn="true"
NoWaitForCompletion="true" NewConsole="true">
<AnalysisOptions NO_MACH5="1" NM METHOD_GRANULARITY="1"
SESSION_DIR="c:¥MyDir" />
<Path>ClientApp.exe</Path>
<Arguments>/argl /agr2 /arg3</Arguments>
<WorkingDirectory>c:¥temp</WorkingDirectory>
</Process>

</Targets>
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Bt

AnalysisOptions 3%
AnalysisOptions & —Ff&ICEEAT 2 BMEIL. ST 200y v a v OFHEICL -
TEDLYVET, ZOMAOKRBIZHDEREZM L T ZIV), DPAnalysis.exeld
T OFEFENR—E L WEEZEH L E 7,
<AnalysisOptions

SESSION DIR = "c:¥MyDir"

SESSION FILENAME = "myfile.dpcov"

NM METHOD GRANULARITY = "1n

EXCLUDE_SYSTEM DLLS = "1"
NM_ALLOW_INLINING = "1"
NO_OLEHOOKS = "1n
NM_TRACK_SYSTEM OBJECTS = "1"
NO_MACH5 = "1n

FORCE_PROFILING = "1"
/>
SESSION_DIR

FFav, ARy DHHT. AFUSH, NTF—~ A, N7 Fp—< A
FANR—RITCHEHLET, 707 7 ANAMEOF—5y ML o TERESR Tzt Y
ary Ty ANDRIET 4 L7 MU EBELET, ZOBMERTE LWGE,
Dy var 7y AnEa—4—0My Documents ¥ 721X Documents 7 « L'~ kU
\CHEA S FE§, SESSION_DIR & SESSION FILENAME O & H 5 HIRE LW A
DPAnalysis.exeldt v i a v O TEIMRIEEFTO AT ZRDE T,

SESSION_FILENAME

FFav, BNy OB, AFVOH. RT3 —< AN, N7 A
TXFAN—RICHEHLET, 2O0¥—Fy ML TAERSNzEyvary 774
NOEyva b ERELET, ZOBMEEZIRTE LR\VWA. DPAnalysis.exeld
H—Ilr sy NDA A =T LT EMAEHE T (ilexplorel.dpprf 72 ¥). —E7Z
AR LET, AANIHEELTHT 4 L7 PUITRELZ2WEA. 7 7 A /ViX
o —4—@OMy Documents T « L7 b UIIEMEILE T, SESSION FILENAME &
SESSION DIRD EH 6 HIEE L7254, DPAnalysis.exeldt vy a v OkT
RRZERAFG T O A1 % RO E T,

NM_METHOD_GRANULARITY

AT as, W7 =< AHTHM L, 77— IEDREZ A Y v B LYK
ELET (F740 MITLL),, ZORMEZRET DI2E, 1OEZEELET,
CORMEEEET DL BIIIRY £,
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EXCLUDE_SYSTEM_DLLS

AT vav, N7 xF—< ARG THERL, VAT A A A=VERALET, Z0ORK
PEFRET DI, 1OEERELET, ZOREEEKT DL, Whiz £,

NM_ALLOW_INLINING

FTav, BNy DM ERT = U ASGHTTHEA L, WO LSV EFRE
LET, £ T4 AV ROFITRRA VA Ry VAT —2a VEANILET,
[ T4 VB EA ARy A L NTB] 70T ¢ LRA%ETT, 40 T4 VB
AVARNGNAY NTHIZIE, 1OBEZBELET, ZOBREEEKT S &, B
B ET,

NO_OLEHOOKS

FFar, N T F—< U AGHTHER L, VAT A I TV NOBAET 7T 4
TWCLET, CORBMERET DI, 1LOEEIEELET, ZOBMEEZENKT S &,
NI F9,

NM_TRACK_SYSTEM_OBJECTS

FTav, ARVSHCTHEAL, BV Y CELL TV MBI EXIC, v
AT LFEIEY—=RKR=FT 04T V=27 FEIV Y TCEEELET, ZOBMHERTE
THITIE, LOEERIEELET, ZOBEEZEKT S L. BRIV 4, T+
hOYREE (FEZ)) TIiE, VAT L VY —ARFEHIEZ0MOT a7 7 4 LS TV
VY—RET TV r—ra BT EEICEHD Y ToONTEATYED YT a2
WTEET,

NO_MACH5
T ay, NI = AN ERT =~ A X AR— N TCHEH L, o FEST

TV r—=varDA Ly FIZERSNRMEZELET, ZOBRMEZRET HIC
I 1OEEZFELET, ZORMEZEIKT L L BOITLRY £,

FORCE_PROFILING
FFvas, BNy URHTE R T A2 P AGHTCHEA L, v —Y a— FERT
DevPartner %A 7 4 7 CIC++ A VA by VAT — a U aEEHETITER I

TV r—=varora A EBRRHLET, ZOBMARET ST, LOEE
BELET, ZOBMEANT D L, B\ 9,
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CENOLLE

Ll

=4
BERDER

NIT+—I VR

=1 HRLye AEY  RIF—IVR TEZ8— T
NM_METHOD_GRANULARITY 'e)
EXCLUDE_SYSTEM DLLS 0]
NM_ALLOW_INLINING e e)
NO_OLEHOOKS o)
NM_TRACK_SYSTEM_ OBJECTS e
NO_MACH5 @) @)
FORCE_PROFILING O (@)

THLURH Process & 1=[% Service & 121 F1=1%0

HER Process. Service

NE Tl

A Tvarv, BEOX =Ty b TutAERE S —F Y N = RIZTH A LR
PaERLET. WALy VI AT VG, ST =~V AGHORT 0RT 4
3T A EMEICIZ. Visual Studio D7 a2 3T 4 U4 RUNLT 7 A TEET,
Service N CAnalysisOptions Z T A2 L FIToRL 9,
<Service CollectData="true">
<AnalysisOptions NM_ METHOD GRANULARITY="1"
EXCLUDE_SYSTEM DLLS="1" NM ALLOW_INLINING="1"
NO_OLEHOOKS="1">

</Service>
Path E¥
<Path> c:¥MyDir¥target.exe </Path>
L
FTHLURH 1
REXR Process
nE EITARET 7 A LADISR
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1

Bt
BEROER

1

=4
BERDER

W, FATHRET 7 A NOZEEEMI/ S A F 213 S A fRE L £3, EITRETY 7
ANBERIEDT 4 V7 FIICHLHGEEIL, RAZRETTICIATIRRY 7 A V4 &R
ETEET

Process HHENTPath ZHHT 262 LA FIZRLET,

<Process CollectData="true">

<Path>ClientApp.exe</Path>

</Process>

Arguments E&

<Arguments>/argl /arg2 /arg3</Arguments>

2L
THhLoRHE Process & 1=[d Service Z&(20F=1F 1
HER Process. Service
S L

T arv, BLIEBEEDT 740 MIbHY E8A, #—47 v hDprocess 713
service [ZTET RN,

Process Z &N TArguments 3 24120 FITRLET,
<Process CollectData="true">
<Arguments>/argl /agr2 /arg3</Arguments>

</Process>

WorkingDirectory B3k

<WorkingDirectory> c:¥MyWorkingDir </WorkingDirectory>

L

FThLoR# ProcessE&E F -l Service ER & (21
HEH Process. Service
S A=y b TaLY FYADIKR

FTvar, BELEGEOT 74 MIHY ERA, X—F v b Tk AEliZ
B =0y NP —EROEET L7 MU ERELET,
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151 H D Process BHEWNIZ R A kL CWorkingDirectory Z {4 262 LL FIZR L
*7,

<Process CollectData="true">
<WorkingDirectory>c:¥temp</WorkingDirectory>

</Process>

Excludelmages %

<ExcludelImages>
<Image>ClassLibraryl.dll</Image>
<Image>ClassLibrary2.dl1</Image>

</ExcludeImages>
B 2L
EFRDIER
FThLoR#E Process &71=1& Service & 120F =& 1
REH Process. Service
A Image
FE FTFvarv, A LIEGEDOT 74V NMEIHY FHA, ¥—F v b TevAEiT

S0y b P—EATE= RENTHEIS, Ta 7 7 AV LRV 1D EDA A=Y
(LRR7Z2L) Z2EHRLET.

1 Process % 3% N T ExcludeImages # i fH T 2412 LI FIZr LET, Image BEHRIX
ExcludeImages NIZE ENS Z LIZEE LT EEN,

<Process CollectData="true">
<ExcludeImages>
<Image>ClassLibraryl.dll</Image>
<Image>ClassLibrary2.dll</Image>
</ExcludeImages>

</Process>
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Service X%

<Service
CollectData = "true or false"
Start = "true or false"
RestartIfRunning = "true or false"
RestartAtEndOfRun = "true or false"
RepeatInjection = "true or false"
>

</Service>

2L

CollectData

T arv, truefmlifalseZRELET, AT D ET 740 NI true T,
H—2y N P—BRZONTT BT 7 A NVEFHCT E0E I NEERELET,
Start

A7 a, truef izt falseZRELET, AT D LT 7 4L M true TY,
DPAnalysis.exe NRE L7=¥ —7 v BTN E I NERELE T, falsell
RETDHE, ZD0F—Fy M T 5707 7 A VITENZROETH, ¥—F v b
TR SN FER A, MENOTFETRIZH—EANRBINZEEITT a7 7 A AN
Bth S ET,

RestartIfRunning

A7 ar, true Toldfalse ZEELE T, AT 5 LT 740 ML false T,
RestartIfRunning % truellRETH &, HEELEYV—EANRKA R ava—
X TEITINTWDHYA . DPAnalysis.exe |l IZ DOV —EAOHEHZHAITLET,

RestartAtEndOfRun

AT al, trueFniifalse#HELET, BT LLET 74/ M false TY,
true ZHRET D &, FEITOK THIZ DPAnalysis.exeld (kv v a vy 77 A 0%
ERRLT) —E2oFEE 23T LET,

RepeatInjection

F 7 g, true £izldfalse HIEELE T, AT H LT 7 40 MMEfalse TT,
false ZWIRIICIEET A E T, ¥ —7 v MIETENA =N T 7 7 A vENET,
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BEHRDOHER

£l

=4
CEOLEE

THhLURH BRI 7A4I)LIZiE. i< EH 1 DD Process Bk
Fi(E Sernvice ERERETILENHYET,

HEXR Targets

S AnalysisOptions, Path, Arguments,

Working Directory. Excludelmages. Name. Host

A=y b - A EEELET,
Targets EH#EWN T Sservice AT 242 LA MR LET,
<Targets RunInParallel="true">
<Service CollectData="true" Start="true"
RestartIfRunning="true" RestartAtEndOfRun="true">
<Name>ServiceApp</Name>
</Service>

</Targets>

Name E%&

<Name>MyServiceName</Name>

L
THLURH 1
HEX Service
NE H—ER%

W, y—EA ary ha—L v X =Ty [IRFESN TN DT —EZADAHT, ZHud,
NET START =2~ > RS2 & EIEHT 2401 RL T,
Service W TName Z i [T 2B Z L FITR L E T,
<Service CollectData="true">
<Name>ServiceApp</Name>

</Service>
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=4
BEROER

Ll

Host B

<Host>hostmachine</Host>

2L
FThLoRE Process &71=Id Service T & (20F=1E1
REH Process. Service
S RA M IVEI—2 DR

FTvarv, B LIEGEDT 74V NMEIHY FHA, ¥—F v b TevAEiT
B—iy N P—EZADRA N vV U ERELET,
Service N CHost T 26 Z U TR LE T, ZOHNITHLIED Name EHE )N
GEENTVWASZ LICHEBELTIEE N,
<Service CollectData="true">

<Name>ServiceApp</Name>

<Host>remotemachine</Host>

</Service>

XML 7274 EFEAL=-Web 7Y r—S3o07Oa7 740

—fEHIC, Web 70 7 7 A WICBEMRR H D F ot 2%, 7T 7P, Web ¥ — 33—,
ASPNETV—0— 7ut®AD3>TYT, 25320 hIT1ODOHERT 7 A
MZEDDZ ENTEET, 77 7P L ASPNET 7 2 & A X <Process> EHENIZI
ELET, Web P ——ld<service>ERNTHE L., <Name>HEI TH—t 24 %
WAL ET, IISOLE, Ziidiisadminile ) £,
I 2R L ET,
<?xml version="1.0" ?>
<ProductConfiguration xmlns="http://www.compuware.com/products">
<RuntimeAnalysis Type="Expert"/>
<Targets>
<Process CollectData="true">
<AnalysisOptions
SESSION DIR="z:¥SessionFiles"/>
<Path>aspnet_wp.exe</Path>
<Host>remotemachine</Host>
</Process>
<Service CollectData="true" Start="true"

RestartIfRunning="true"
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RestartAtEndOfRun="true">
<AnalysisOptions
SESSION_DIR="z:¥SessionFiles"/>
<Name>iisadmin</Name>
<Host>remotemachine</Host>
</Service>
<Process CollectData="true" Spawn="true">
<AnalysisOptions
SESSION_DIR="c:¥SessionFiles"/>
<Path>iexplore.exe</Path>
<Arguments>
http://remotemachine/WebApplication/
StartPage.aspx
</Arguments>
</Process>
</Targets>

</ProductConfiguration>

LR T 7 A MFU T 2FEITLET,
¢ remotemachine EMASPNETVY —#h— Fut ADF —ZIEZH N LET,

& UVET—h artPa—HEdDinetinfo.exe (iisadmin) OTFT —XINEEZHR)
WL, a7 7 A NADBEGBEIND Lo IR LET,

¢ VE—bFarta—%LEOWeb_X—UTHRRENIca—H)L 2 Ea—H|Tx
LT, =WV 7530V %B&F 73, aspnet_wp.exeBNVE—F 22—
X CETIN, TuZ 7 AVPREBISNET,

nD—H) AL Ea—2DT TV EHLS L, (aspnet_wp ZEIELT) UE—Fh 22
Pa—X EOIISIEYVE—h arPa—Z THEBSNET . By ary 774103
BEWICERET L7 BVICRESRE T, KBS T, VE—F arEa—#
FZHRGFEO Yy B T HERRTATEER L By vay 7y vET a7y
ANERIELT a2 Ea— 2R FLET, ZOFID <Process> %K & <Service>
BEDz:¥ RTA TV ET,
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HOTIEBREI 7ML

DevPartner Studio @A > A b —/LIZiX, ZTHHDH 7L FEAED BHHOHEK
TrANLNEENET, INHEEFALELTHHALTHZZ LOME T 7 A4 VEE
Jﬁl—/ij—o

Sample.Process.Config.xml
Sample.Service.Config.xml
Sample.WebApp.Config.xml

Sample.DCOM.Config.xml
Sample.ClassicASP_TIIS_High Isolation.Config.xml
Sample.ClassicASP IIS_Low Isolation.Config.xml
Sample.Multi_ Process.Config.xml

FIFIV DA LA R—LTIE, LTOFT 4 L7 RVIZT7 7 A AP SVET,

<install drive>:¥Program Files¥Compuware¥DevPartner Studio
¥Analysis¥SampleConfigs¥

*%E : DPAnalysis.exeT[X7 34— a—FK (Visual C++6.07 T & —
3% Visual Basic6.0 7 TN — a3 g E) #FA VA LYILAV LT
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